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1 Presentación 

Desde la implantación del Máster SIG de la UPC (1997-98) hemos tratado de formar a 
profesionales en este campo, con capacidad y habilidad para aplicar los recursos que 
ofrecen los  SIG cara a resolver cuestiones de planificación y gestión urbana. Este es un 
taller específico que aborda una experiencia sobre el SIG de gestión de información 
urbanística en el ámbito local. 

Hoy resulta mucho más abordable por técnicos e instituciones la realización de mapas 
donde representar elementos y lugares singulares, donde referir información 
geoespacial de interés, pues se puede ejecutar con ordenadores estándar a precios 
accesibles para los profesionales, las administraciones y los ciudadanos. 

Con ello se ha favorecido la incorporación de los SIG en muchas administraciones  de la 
mano del área de planeamiento urbanístico, habitualmente acostumbrada a trabajar 
con herramientas de diseño asistido por ordenador, pero sin demasiados 
conocimientos de los recursos SIG. 

Este documento pretende explicar ese potencial analítico y de conocimiento, mediante 
un caso de estudio que muestra el proceso de elaboración de información en SIG , con 
utilidad estratégica y práctica en las decisiones urbanas que atañen a la mejora y 
transformación de un centro urbano consolidado, la creación de vivienda, el fomento 
de ejes comerciales, entre otros. 

Plantea una cuestión de actualidad, pues en la mayoría de las actuaciones urbanas se 
requiere de información georeferenciada, como base del debate y reflexión necesaria 
para la elaboración  de propuestas y la toma de decisiones. Una información muy 
valiosa al abordar los la documentación de  distintas figuras de desarrollo urbanístico 
tales como los Planes de Mejora Urbana, los  Planes Locales de Vivienda (PLH) y los 
planes de Mejora de Barrios Desfavorecidos entre otras. 

Este documento, aborda con un enfoque pedagógico de lo que podría ser una 
experiencia de implantación de un SIG local de planeamiento urbanístico y sus 
aportaciones al conocimiento urbano. Reúne el conjunto de bases de información 
esenciales, Topográfico, Planeamiento urbanístico y Catastro; describe formatos y 
contenidos relevantes; explica los procesos de gestión de datos, transformación de 
formatos y creación de resultados próximos al ente local tipo. Incorpora un taller de 
auto aprendizaje  que desarrolla un prototipo de estudio guiado, sobre las bases, los 
procesos, los formatos, cara a la obtención de los resultados, de mejora de la calidad 
de la información y creación de nuevos conocimientos de gran utilidad para 
planificadores y gestores. 

En suma, se propone descubrir el potencial y utilidad del SIG a profesionales y 
técnicos, fomentar la curiosidad y evidenciar las oportunidades de mejora en 
conocimiento más interesantes en este contexto. 
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2 Contexto 

Actualmente las entidades locales disponen de muchos recursos de información 
geoespacial para llevar a cabo la gestión de su territorio. El crecimiento y desarrollo de 
las cartografía digital se ha visto fortalecida en la métrica,  el rigor y la precisión de los 
datos (3D),  ajustados a escalas muy  útiles para los entes locales, (como la escala 
1/1000) y con una ley que regula los requerimientos de uso1, a parte de las 
prescripciones técnicas de estructura y formatos2 ajustados y coordinados entre los 
principales entes productores (ICC, MMAMB, Diputaciones, y los propios municipios). 

La iniciativa INSPIRE de la Unión Europea es el primer paso de una amplia iniciativa 
multilateral que inicialmente dirigirá su interés sobre la información  espacial necesaria 
para políticas medioambientales y que estará disponible para satisfacer las 
necesidades prácticas de otras  áreas, como la agricultura y el transporte. En resumen, 
esta iniciativa tiene como objetivo poner a disposición de los ciudadanos  una gran 
cantidad de información geográfica producida por las administraciones públicas. 

El Open GIS Consortium (creado en 1994) desarrolla técnicas y estándares de sistema 
abiertos en el campo de la Información Geoespacial (IG), aporta una mejora el 
intercambio datos, es decir, la interoperabilidad3. Unos estándares de datos y servicios 
que cualquier software SIG puede manejar, independientemente de cuál sea el 
fabricante del software. Ello constituye un beneficio sustancial para los usuarios que 
pueden acceder desde su ordenador conectado a internet a distintos servidores de 
mapas4, solicitar y recibir información de su parcela del catastro, o la ortofoto de su 
barrio5. Los servidores de mapas se convierten así en unas fuentes de información 
relevante con un crecimiento extraordinario en los últimos tiempos, también en 
aquellos ayuntamientos que facilitan el acceso a  ciudadanos de su información urbana 
y mapas del municipio6. 

                                                        
1 Llei 16/2005, de 27 de desembre, de la informació geogràfica i de l’Institut Cartogràfic de Catalunya 
2 Como el “Model de Dades Cartografia de Planejament Urbanístic”, elaborado por la Oficina Tècnica de 
Cartografia i SIG Local del Àrea d'infraestructures, Urbanisme i Habitatge de la Diputació de Barcelona 
3 Entendida como capacidad que tienen los sistemas de comunicarse, ejecutar procesos o transferir 
datos entre sí, sin necesitar ningún conocimiento específico, sólo con conocimiento genérico, estándar 
sobre las características comunes de dichos sistemas 
4 Con unos estándares de datos establecidos por el OGC en GML (Geographic Markup Language) y entre 
los servicios  encontramos los WMS (Web Map Service) y WFS (Web Feature Service), que llamaremos 
servidores de mapas 
5 A partir de la cartografía elaborada por el ICC (Institut Cartogràfic de Catalunya) 
6 Algunas experiencias destacables son la del SITMUN que integra cartografía y bases de datos con 
tecnología servidor de mapas vía web gestionada de forma centralizada por la Diputación de Barcelona 
(http://sitmun.diba.cat/sitmun/indice.htm) 
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Las nuevas infraestructuras de datos espaciales (IDE) han desarrollado un conjunto de 
“políticas, tecnologías, estándares y recursos humanos para adquirir, procesar, 
almacenar, distribuir y mejorar la utilización de la información geográfica". La IDE 
Catalana7,  ha ejercido un papel destacado en la difusión de geoinformación y servicios 
asociados, y ha fortalecido la accesibilidad y uso compartido de información. 

Con todo el ciudadano tiene un fácil acceso a la información de su entorno a través de 
servicios centralizados en geoportales alojados en el propio ayuntamiento 
(topográfico, planeamiento, redes de vialidad o servicios), diputación, consejo 
comarcal, o bien a través de canales distribuidos como la IDEC que puede acceder a  
cartografía temática del catastro, al planeamiento urbanístico, ortofotos. 

Este acceso a información compartida exige ciertos estándares de la elaboración de la 
información urbanística8, pues en la medida que se pretende abarcar un territorio 
continuo se evidencian ciertas carencias “semánticas” al referenciar los códigos de 
formas distintas9, dadas las singularidades de cada territorio. 

Este ha sido, un tema de abordado por el Departamento de Territorio y Sostenibilidad 
(antes DTOP) de Generalitat de Catalunya. Al iniciarse el proyecto de Mapa Urbanístico 
de Catalunya, se partió de unos primeros criterios de sistematización del planeamiento 
urbanístico de Cataluña (2008), que actualmente han evolucionado hacia un sistema 
de codificación estándar del planeamiento urbanístico (2011) que es una codificación 
sintética, jerárquica y flexible, como un estándar de intercambio de los datos 
urbanísticos digitales,  que puede ser útil para la redacción de nuevos instrumentos de 
planeamiento urbanístico. De este modo, el Mapa Urbanístico de Cataluña (MUC)10, 
permite la lectura continua de la ordenación urbanística de Cataluña, y resuelve las 
diferencias de codificación, lenguaje y representación que tienen los diferentes planes 
urbanísticos vigentes en la actualidad. 

Esta aplicación está coordinada con otro proyecto excepcional, que avanza en el 
conocimiento y gestión de los municipios del ámbito metropolitano de Barcelona.  Nos 

                                                        
7 El portal IDEC se puede encontrar en http://www.geoportal-idec.cat/geoportal/cat/ 
8 En Cataluña la legislación vigente es: Decret legislatiu 1/2005, de 26 de juliol, refós de la Llei 
d’urbanisme (LUC).publicat DOGC núm. 4436 – 28/07/2005; Decret 305/2006, de 18 de juliol, Reglament 
de la llei d’urbanisme (RLUC). publicat DOGC núm. 4682 – 24/07/2006; Llei estatal “del suelo” ( 8/2007 
de 28 de maig); Decret llei 1/2007, de 16 d’octubre, mesures urgents en matèria d’urbanisme. publicat 
DOGC núm. 4990 – 18/10/2007. 
9 Cada  Plan de Ordenación Urbanístico Municipal,  aparte de clasificar suelo (su aptitud urbana), 
delimitar los sectores sujetos a planeamiento derivado, establece una cualificación urbanística de zonas 
y sistemas de forma singular para cada PGOU, hecho que dificulta la identificación de tejidos y usos 
predominantes de forma continua. 
10 Se puede visitar en el enlace http://ptop.gencat.cat/muc-visor/ 
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referimos al Portal Web de Planeamiento Urbanístico11 realizado por  los Servicios de 
Ordenación Urbanística de la MMAMB, que integra la cartografía del refundido de 
planeamiento urbanístico accesible de forma continua de todos los municipios y  
referida sobre el topográfico. 

  

                                                        
11 Permite la consulta del texto refundido de planeamiento urbanístico de forma continua en el ámbito 
metropolitano y la descarga de series completas de hojas 1:1 000 por cada uno de los municipios 
(http://www.cartografia.amb.cat/planejament) 
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3 Estudios urbanos y SIG 

Los ayuntamientos generan  un importante volumen de información casi en su 
totalidad con referenciada a su territorio. Unas bases de información sobre la 
población (padrón), el territorio (licencias de obra, planeamiento urbanístico,  
infraestructura viaria, redes  alumbrado, equipamientos…) y su economía (Impuestos 
de actividades, IBI, etc.). Desde el momento en que un ayuntamiento dispone de una 
base gráfica digital, posee un denominador común de los datos anteriormente 
mencionados. 

Por definición, los SIG como “… sistema compuesto por elementos informáticos 
(Hardware y software) y métodos diseñados para permitir la adquisición, gestión, 
manipulación, análisis, modelado, representación y salida de datos espacialmente 
referenciados, que ayudan a resolver problemas de planificación y gestión”12. 

Así las cosas, para manejar una cantidad importante de datos de manera eficiente es 
necesario utilizar un Sistema de Información que almacene, actualice y explote el 
conjunto de estos datos. Si una parte importante de estos datos tiene un componente 
de localización (forma y posición), necesitaremos gestionarlos con un Sistema de 
Información Geográfica (SIG). 

Los SIG pueden aportar, por su capacidad de análisis y manejo de datos, un 
conocimiento exhaustivo de la ciudad y su funcionamiento. Una información valiosa en 
la planificación y gestión de los procesos de transformación urbana. Una manera más 
precisa de conocer el estado del municipio en tiempo real. 

Aun cuando en muchos municipios no se disponen de recursos técnicos suficientes 
existe una necesidad creciente del estudio urbano,  sus tejidos edificados, de viviendas 
y sus habitantes. En algunos casos ha visto una reducción del gap digital con el uso de 
infraestructuras como la IDEC13. La capacidad de análisis urbana de las bases actuales 
merece ponerse en consideración de los futuros técnicos en SIG. 

Nuestra experiencia en los estudios realizados en el CPSV14 para diferentes entes 
locales, ha servido para destacar el interés y  el alto potencial de estudio urbano de los 
SIG. Los temas de estudio han desplegado que se han desarrollado se encuadran en 
cuatro temáticas. 

                                                        
12 Definición del National Center for Geographic Information and Analysis de EE.UU 
13 Garcia-Almirall, P y otros (2007) STUDY OF THE SOCIOECONOMIC IMPACT OF THE SPATIAL DATA 
INFRASTRUCTURE IN THE REGION OF CATALONIA. European Commission DG Joint Research Centre. 
Institute of Environment and Sustainability. 
14 El Centro de Política del Suelo y Valoraciones (CPSV), Centro Específico de Investigación de la 
Universidad Politécnica de Barcelona (UPC) dedicado a la formación y investigación especializada en los 
campos de la planificación territorial, la gestión y administración del urbanismo, entre otros 
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1) Estudios de caracterización y análisis urbana en SIG, desarrollan una metodología 
integrada del estudio geoespacial de la ciudad incorpora datos sociales, económicos y 
urbanos, sobre la base de cartografías urbanas, mapas con datos elaborados del 
catastro, bases de datos municipales entre otras. 

Un primer proyecto es el Análisis y evaluación de la realidad Territorial y Urbana 
sobre plataforma SIG15, que es un avance en la línea de  estudios sobre la estructura 
espacial de valores urbanos16  realizados para el catastro, también aplicado al estudio 
de la intensidad de actividad económica (vinculado a la fiscalidad del IAE, o a la 
gestión de oficinas) por tramos de calle. Así como, la elaboración de Indicadores de 
sostenibilidad urbana, o de parámetros urbanísticos de los tejidos urbanos, entre 
otros estudios.  

 

Estudio sobre los valores de vivienda plurifamiliar en la AMB 

   
Elaboración CPSV para el citado proyecto realizado para el Catastro de Barcelona (2005) 

 

Determinación de los ejes terciarios y comerciales de Barcelona 

 

Elaboración CPSV para el proyecto revisión de valores catastrales realizado para el Ayuntamiento de Barcelona 
(2001) 

  

                                                        
15 Se trata del primer proyecto competitivo en la temática, dirigido por Pilar Garcia Almirall y realizado 
para la Secretaria General de Planificación y Concertación Territorial (MOPTMA). (BOE 100 de 27/04/93) 
16 Garcia-Almirall, P. (1998) La valoració urbana en base a les noves tecnologies de SIG. Tesis doctoral UPC inédita 
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SIG y Geomarketing: Modelos de análisis de los Edificios de oficinas de Barcelona y su 
entorno 

     
Elaboración CPSV para el citado proyecto realizado para la empresa de Servicios de Gestión y Marqueting 
Inmobiliario S.A. (2006) 

Estudio de los parámetros urbanísticos de la ciudad de Barcelona 

     
Elaboración CPSV para el citado proyecto realizado para el Gabinete de Estudios Urbanísticos del Ayuntamiento de 
Barcelona (2009) 

 

2) Estudios encaminados a la gestión de información urbanística municipal17, el 
inventario y gestión de patrimonios de suelo18, su potencial edificable, de vivienda, 
así como los procesos de gestión de suelo.  

     
Elaboración CPSV para el citado proyecto realizado para el Institut Català el Sòl (2009) 

                                                        
17 Proyecto competitivo realizado en el CPSV (1993) “Desarrollo de una aplicación sobre plataforma 
SIG, encaminada a facilitar la gestión de un ayuntamiento tipo” Ayuda a la Investigación de la Escuela 
de Administración Pública 

18 Un primer proyecto CPSV (1994) Realización de un SIGT que asista al MOPTMA en el diseño de una 
Política de Suelo. Aplicación al patrimonio de SEPES. Ayuda de la Secretaria de Estado de Política 
Territorial y Obras Públicas. MOPTMA. En 2009 se elabora un Sistema de Información Territorial para la 
gestión del patrimonio de suelo del INCASÒL

   
Eix prime Eix secondari Parc Tecnòlogic
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3) Estudios sobre el potencial de viviendas en tejidos urbanos consolidados19. Un 
estudio complementario a la redacción del  Plan Local d'Habitatge20 o bien para el 
estudio de Modificaciones de Plan de Ordenación Urbanística Municipal, que trata de 
estimar y caracterizar el potencial de viviendas de posible en el suelo urbano 
consolidado como transformación individual de los solares y edificios, a partir del 
análisis de los procesos de transformación existentes y de las calificaciones del 
planeamiento urbanístico. 

        
Elaboración CPSV para de estudio del potencial urbanístico de Vilafranca del Penedès realizado para la Diputació de 
Barcelona (2009) 

 

   
Elaboración CPSV para de estudio del potencial urbanístico de un ámbito para el Gabinete de Estudios Urbanísticos 
del Ayuntamiento de Barcelona (2011) 

 

 

                                                        
19 Se ha estudiado Vilafranca del Penedès, el centro histórico de Sant Cugat del Vallès. También se ha 
estimado los cambios en la ordenación del núcleo de Sant Andreu Barcelona.  
20 El Plan Local de Vivienda (PLH) es el documento técnico que, partiendo del análisis de la situación de 
la vivienda en el municipio y de las condiciones de contexto (socio-económicas, urbanísticas,  de 
organización municipal, etc.), establece el diagnóstico de la problemática y de las necesidades 
comarcales en materia de vivienda y los objetivos, estrategias y líneas de actuación para su resolución 
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4) Estudios de sistematización en SIG del inventario y catálogo de protección de 
patrimonio edificado. Utilizando herramientas cartográficas y el modelado 3D a partir 
de sensores de alta precisión como el láser escáner con objeto de revisar el  
cumplimiento de las alturas reguladoras y las edificaciones irregulares en azoteas. 

 

Imágenes del Plan de Protección del Patrimonio de LLoret de Mar. Planos de 
fachadas, modelos tridimensionales de volumetría y mapa de alturas 

 

  
Elaborado por el Laboratorio de Modelización Virtual de la Ciudad (LMVC), plataforma tecnológica del CPSV en la 
Escuela Técnica Superior de Arquitectura de Barcelona 
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4 SIG en el ámbito local  

Entre las funciones habituales de la administración local existen unas de tipo técnico, 
otras administrativas y otras de planificación. Todas ellas con un alto componente 
territorial. Las técnicas han utilizado tradicionalmente el CAD para el control, diseño y 
mantenimiento ciudad. Las de administración temas fiscales y legales (Población, 
Catastro, Actividades económicas) a menudo han iniciado la utilización de los SIG. Las 
que se dedican a la  planificación de Planes de Protección Civil, Mapa escolar, Planes 
de Ordenación Urbanística Municipal, son las que requieren de un mayor nivel de 
capacidades analíticas que aportan los SIG. 

Los estudios recientes sobre el uso las TIC y específicamente del SIG en las 
administraciones locales21 indican su progresiva incorporación en diferentes ámbitos. 
Inicialmente los SIG se utilizaron para inventariar y representar información territorial. 
El catastro y el planeamiento siguen siendo los usos más habituales de esta tecnología 
en el mundo local. 

Por una parte, el potencial de análisis de la información georeferenciada que tienen los 
SIG les ha ido abriendo nuevos campos de aplicación. Por otra, las nuevas aplicaciones 
cada vez más manejables, permiten elaborar diferentes modelos o visiones de la 
ciudad y, incluso, hacer simulaciones del comportamiento de variables. Es decir, que 
pueden llegar a ser la piedra angular de la planificación estratégica del municipio. 

Entre estos dos extremos, desde el uso mínimo, hasta convertirse en el centro de la 
planificación del ayuntamiento, se pueden enumerar una serie de usos: 

 Cartografía base y cartografía topográfica: Mantenimiento de la cartografía 
del municipio, de acuerdo con organismos como el Instituto Cartográfico de 
Cataluña o por parte de los propios servicios de topografía del ayuntamiento 

 Parcelario catastral: Mantenimiento el catastro, y vínculo con el cobro del 
Impuesto de Bienes Inmuebles (IBI) y la gestión tributaria 

 Planeamiento urbanístico: Mantenimiento y publicación del planeamiento 
urbanístico del municipio incluido el registro de sectores o figuras de 
planeamiento en desarrollo. Se puede enlazar con la normativa urbanística y 
la concesión de licencias de obras y licencias de actividades y como 
herramienta para elaborar el planteamiento refundido. 

 Inventarios georeferenciados: Puede abarcar desde el mobiliario urbano hasta 
el catálogo del patrimonio histórico y artístico, árboles catalogados, bienes del 
patrimonio municipal de suelo y vivienda 

                                                        
21 Sistemes d’informació geogràca i programari lliure a l’administració local.  Editada por Localret 
(http://www.localret.net/), Octubre 2010. 
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 Tráfico: Mantenimiento de información sobre señalización horizontal y 
vertical. Estudios de movilidad y almacenamiento de información sobre 
accidentes, para detectar puntos negros de la red viaria y planificar 
actuaciones de mejora. 

 Redes de infraestructura: Mantenimiento de información sobre redes de 
telecomunicaciones, de alcantarillado, y otros servicios. Cálculo de 
capacidades y planificación del desarrollo. 

 Optimización de servicios prestados por el ayuntamiento: Recorridos para la 
recogida de basura, mantenimiento de los parques y jardines, de las zonas de 
aparcamiento, etc. 

 Herramienta de toma de decisiones estratégicas: Ubicación adecuada de 
equipamientos deportivos, sanitarios, etc. 

 Servicios al ciudadano: Mantenimiento del Padrón Municipal, gestión de 
ayudas y subvenciones, vinculación con el registro municipal 

 Incidencias en la vía pública: Georeferenciación de los avisos de los 
ciudadanos o de los agentes municipales sobre averías alumbrado, 
desperfectos en la red viaria, etc. Permite la planificación de la solución de 
estas incidencias, optimización de recorridos de la brigada, etc. 

 Gestión de la seguridad ciudadana: Georeferenciación de datos sobre 
seguridad, para detectar zonas con problemas de conflictividad o de 
seguridad 
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Fuente: Sistemes d’informació geogràfica i programari lliure a l’administració local.  Editada por Localret, Octubre 
2010. 

Tal como se aprecia en el gráfico anterior, los SIG son de uso habitual entre los 
servicios técnicos, Medioambiente, Atención al Ciudadano y servicios económicos 
(Catastro). En todos ellos existe un interés creciente en la utilización del SIG.  

4.1 Experiencia SIG de gestión de información urbanística local 

La experiencia de implantación de un SIG local de planeamiento urbanístico es 
bastante reciente22 sin embargo, con la exigencia de publicación del mismo se ha 
evidenciado con fuerza el potencial de estudio orientado a la planificación y gestión 
local. 

En términos generales, la información urbanística que gestionan las entidades locales 
es muy compleja y cambiante en el tiempo. Para elaborar este documento se ha 
consultado distintas instituciones y entidades locales para conocer su experiencia en la 
implantación de herramientas SIG (Ajuntament de Granollers, Ajuntament de 
l’Hospitalet de Llobregat, Ajuntament de Sant Cugat del Vallès, Ajuntament del Prat de 
Llobregat, Diputació de Barcelona, Institut Cartogràfic de Catalunya). 

                                                        
22 Los ayuntamientos de más de 10.000 habitantes deben publicar su planeamiento, según el Decret 
305/2006 de 18 de juliol, Reglament de la Llei d’Urbanisme de Catalunya 
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De su experiencia se ha podido conocer las necesidades de información, procesos de 
trabajo y perfiles profesionales que desarrollan su trabajo en este ámbito y de las 
dificultades con las que se encuentran, aunque cada municipio es distinto en relación a 
cuál es la información clave, quien produce la información y quién la revisa y actualiza. 

El responsable del SIG es una figura nueva que no se adscribe a un área específica,  
pues hasta ahora había pocos expertos formados. Se trata de profesionales con 
capacidad de ofrecer servicios transversales, si bien a menudo, se  inscriben en  el área 
de Urbanismo, siendo entonces el arquitecto municipal el gestor del SIG. 

Para la gestión de la información de Planeamiento, encontraremos entre otras las 
siguientes capas de información: 

 Situación básica del suelo (según la Ley de Suelo) 

 Protecciones  transversales, sistema hidrográfico, redes de movilidad, etc. 

 Planes Territoriales 

 Planeamiento General (Planes de Ordenación Urbanística Municipales y 
Plurimunicipales, Normas de Planeamiento Urbanístico y Programas de 
Actuación Urbanística Municipales y Comarcales) 

 Planeamiento Derivado (Modificación Puntual del Plan General, Sectores de 
Planeamiento, Polígonos de Gestión) 

 Clasificación (según la legislación autonómica) 

 Sistemas (Generales y Locales): Espacios libres, Equipamientos, 
Comunicaciones, Servicios Técnicos y Viviendas dotacionales 

 Calificaciones urbanísticas (zonas de uso privado) 

 Características de la edificación: Alturas, edificabilidad, usos admitidos, 
alineaciones, etc. 

4.2 Datos con los que se trabaja en un SIG de planeamiento 

Históricamente esta información se ha recopilado, editado y almacenado en formatos 
CAD para su impresión en papel. 

Es importante poder incorporar estos datos en formato CAD; para ello no es necesario 
abandonar completamente estos formatos sino es posible estructurar su información 
de manera que ésta se pueda incorporar fácilmente al SIG. De esta manera también es 
posible incorporar la cartografía producida por el departamento de topografía a 
medida que se genera. 

La información urbanística que gestiona un ente local debe integrar datos que 
proceden de múltiples productores: 
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 Datos históricos del propio departamento, tanto en soporte papel como 
digital 

 Datos mantenidos por otros departamentos del propio ente 

 Datos de otros organismos o instituciones 

A esta complejidad para el manejo de los datos se añade a la dificultad intrínseca de 
gestionar el territorio, utilizando datos tanto de la propia entidad local como otras 
instituciones: 

 Departamentos que utilizan las bases de información dentro de la propia 
entidad local: Urbanismo, medio ambiente, servicios, tributos (IBI), licencias, 
patrimonio histórico, patrimonio de suelo y vivienda, plano de la ciudad, 
padrón municipal de habitantes, etc. 

 Otras instituciones con las que se trabaja: Catastro, espacios de interés 
natural, Agencia Catalana de l’Aigua, límites municipales, colaboración con 
municipios vecinos, ortofotos, callejeros, etc. 

Las herramientas como los SIG permiten manejar e integrar estos datos heterogéneos 
y darles coherencia utilizando como nexo de unión su componente de localización para 
detectar y solucionar los problemas de coherencia entre bases. 
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5 Preparación de datos para un SIG municipal: Sant Cugat del Vallès 

El caso práctico se ha realizado en base a la experiencia realizada conjuntamente  con 
el Ayuntamiento de Sant Cugat del Vallès y la Diputación de Barcelona. Se trata de un 
estudio piloto denominado "Estudio del potencial de viviendas del ámbito central del 
suelo urbano consolidado de Sant Cugat del Vallès", en el marco de la redacción del  
Plan Local de Vivienda (Pla Local d’Habitatge o PLH). 

El Plan Local de Vivienda es el documento técnico que, partiendo del análisis de la 
situación de la vivienda en el municipio y de las condiciones de contexto (socio-
económicas, urbanísticas,  de organización municipal, etc.), establece el diagnóstico de 
la problemática y de las necesidades comarcales en materia de vivienda y los objetivos, 
estrategias y líneas de actuación para su resolución. 

El objetivo del estudio fue estimar y caracterizar el potencial de viviendas de posible 
construcción en el suelo  urbano consolidado como transformación individual de los 
solares y edificios, a partir del análisis de los procesos de transformación existentes y 
de las calificaciones del planeamiento urbanístico.  

Esta experiencia ha servido para poner de relieve la necesidad de formar a 
profesionales en esta línea, con capacidad de recoger el conjunto de información de un 
ente local, manejar y un articular un análisis orientado a unos objetivos de gran interés 
para la mayoría de ayuntamientos de tamaño medio.  

5.1 Objetivos 

El objetivo del taller es la adquisición de conocimientos por parte del alumnado en el 
uso de un SIG de gestión de información urbanística, haciendo hincapié en los aspectos 
principales con los que tratan  los profesionales que trabajan en este campo. 

Se pretende que el alumnado no se limite únicamente a la utilización de las 
herramientas SIG sino que integre los conocimientos de los que dispone en materia de 
urbanismo para la resolución de los ejercicios. 

5.2 Metodología 

Uno de los objetivos del taller es integrar los conocimientos en materia de SIG con los 
conocimientos de los que ya está familiarizado el alumnado en materia de Urbanismo. 
De esta manera la aproximación a la herramienta no es únicamente la de aprender una 
disciplina nueva sino de integrar unos nuevos conceptos y técnicas a otros 
conocimientos ya adquiridos. 

En cuanto a la operativa del taller, se pretende que los nuevos conceptos se 
sedimenten y se entretejan a medida que el taller va progresando. Para ello los 
conceptos se introducen de manera paulatina: 
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 Inicialmente se introducen los conceptos a estudiar en un ejercicio, 
describiendo de manera pormenorizada los pasos a seguir, para facilitar al 
alumno el conocimiento de la herramienta y la operativa. 

 En ejercicios siguientes se debe aplicar un concepto parecido, esta vez sin 
disponer de esta descripción detallada, para estimular la reflexión del 
estudiantado y evitar que aplique los conocimientos de manera automática 
sin una reflexión crítica previa. 

 Más adelante, el alumnado debe combinar de forma coordinada conceptos 
adquiridos separadamente para desarrollar procesos más complejos. La 
intención es que se utilicen conceptos ya aprendidos de manera original para 
enfrentarse a la resolución de problemas de mayor complejidad. 

5.3 Guión de los contenidos del taller 

Preparación de la cartografía de planeamiento (entrada de datos) 

 Análisis de contenidos 

 Importación de información externa (georeferenciación y depuración) 

  Identificación de la información relevante 

  Selección de datos decisivos para el SIG  

  Georeferenciación de la información 

  Proceso de importación y depuración de cartografía a partir de la 
información CAD 

 Verificación de la posición (WMS ortofoto) 

 Verificación del contenido con mapas temáticos 

 

Preparación datos alfanuméricos y su mapificación en cartografías externas INE 

 Tratamiento de datos del censo: población 

 Selección de datos y cálculo de información agregada 

 Cálculo de parámetros (densidades): Hab/Ha 
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Preparación de datos Catastrales 

 Bases en formato FIN  

 Revisión y selección de datos relevantes 

 Tablas y campos de información más usuales o útiles (Masa, Parcela, 
Construcción) 

 Creación de una base de explotación para la explotación de la antigüedad 
edificaciones 

 

Propuestas de estudio Comercial del Núcleo de la Población 

 Identificación de los ejes comerciales (trabajo con el Registre de 
Planejament) 

 Uso comercial en PB 

 Potencial de crecimiento/transformación de las PB 

 ¿Cuánto techo comercial puede crecer esa zona? 

 

Potencial urbanístico cara a la densificación  

 Tejidos diferenciados según densidad 

 Potencial de techo no materializado 

 Visualización del potencial en 3D 

5.4 Bases de información de los talleres 

En los talleres se trabajará con un conjunto de bases de información heterogénea para 
que el alumnado adquiera el hábito de trabajar con información dispersa y en algunos 
casos incompleta. 

A) Información de planeamiento 

La información de planeamiento se deberá extraer en un archivo DGN. La información 
de este archivo está estructurada para obtener documentación impresa y no está 
concebida para su trabajo en GIS, por lo que será necesario realizar un una serie de 
procesos de georeferenciación y filtrado para obtener entidades con las que poder 
trabajar. 

B) Bases de datos catastrales 

Se proporciona una geodatabase con información Catastral que contiene  unas bases 
gráficas (manzanas, parcelas y volumetría) de un ámbito de estudio delimitado y unas 
tablas con la información alfanumérica del municipio (locales, edificios y parcelas). 
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Se han limitado los campos de información presentes en la geodatabase a los que se 
trabajarán en los talleres. El criterio para seleccionar estos campos ha sido que sean 
representativos de la información que el alumnado pueda manejar profesionalmente. 

C) Información demográfica 

Se proporciona la información demográfica con dos niveles de agregación: Datos del 
Padrón e Información del Instituto Nacional de Estadística (INE). 

Los datos del padrón consisten en una tabla que vincula los datos de habitantes de 
cada parcela con la parcela catastral. Ésta información se ha alterado para proteger el 
secreto estadístico. 

La información del INE se presenta como una capa gráfica con la geometría de las 
zonas estadísticas de toda Cataluña y un archivo de texto de formato específico del 
que se deben extraer los datos necesarios. 

5.5 Operaciones con las bases de información 

A) Trabajo con bases cartográficas 

En los talleres se trabaja con múltiples bases cartográficas: 

 Cartografía de Planeamiento 

 Cartografía Catastral 

 Cartografía del Instituto Nacional de Estadística 

Esta variedad permite introducir la complejidad del trabajo con distintas bases gráficas 
que tienen productores distintos y que se han elaborado separadamente para 
finalidades diferentes. 

Se introducen distintos aspectos acerca de la calidad de la información cartográfica, 
tanto en la exactitud geométrica (sistemas de referencia, disponibilidad de una red 
geodésica municipal), temporal (frecuencia de actualización) y conceptual (conceptos 
distingue la cartografía, nivel de agregación). 

También se hace especial hincapié en la importancia de la correcta interpretación de la 
cartografía en el momento de la generación de la cartografía SIG a partir de la 
cartografía CAD, que hace necesaria la aplicación de conocimientos en materia de 
urbanismo. 
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B) Trabajo con bases alfanuméricas 

El trabajo con bases alfanuméricas en el taller consiste en una serie de operaciones 
que trabajan exclusivamente con datos tabulares: 

 Conversión de formatos específicos a tablas 

 Vínculo con las bases gráficas y otras tablas 

 Operaciones de agregación 

La voluntad de este trabajo es que el alumnado comprenda que no siempre es posible 
disponer de las bases con definición gráfica y al mismo tiempo que descubra  la 
capacidad de análisis que permite el trabajo con datos exclusivamente tabulares. 

C) Trabajo con información externa 

Finalmente, se trabaja con datos de instituciones externas para poner de relieve la 
capacidad de integración de datos dispersos que permite la tecnología SIG, con 
servicios WMS, utilizando en este caso las ortofotos del ICC para comprobar la correcta 
georeferenciación. 
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Pilar Garcia Almirall, Francesc Valls Dalmau y Montse Moix Bergadà  

SIG en la Gestión de la Información Urbanística en el ámbito local  29 

6 Delimitación ámbito de estudio 

Para digitalizar el ámbito de estudio, creamos una Feature Class con Data 
Management Tools → Feature Class → Create Feature Class y la llamamos 
"Ambito_Estudio", estableciendo el sistema de coordenadas que le corresponda. 

En esta capa digitalizamos el ámbito de estudio siguiendo la imagen siguiente como 
referencia, utilizando un servicio WMS con una ortofoto o con el parcelario de las 
bases catastrales como cartografía de base para digitalizar. 

 

La realización de este taller se centra en un ámbito de estudio. La delimitación del 
ámbito de estudio no es una cuestión trivial sino que se determinará según 
distintos criterios según la finalidad del estudio, como por ejemplo: 

 Tipología edificatoria 

 Antigüedad de la edificación 

 Características de la trama urbana 

 Calificación urbanística 

 Características poblacionales 

En el caso de este taller, esta delimitación viene determinada, pero debería hacerse 
por parte del equipo de técnicos que realiza el estudio. 
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7 Trabajo con la cartografía de Planeamiento 

  

1. Examinamos el Archivo DGN (SCU_nucli_eixamplesud.dgn) cambiando sus atributos 
a “sólo lectura” por precaución puesto que Microstation altera el archivo en disco 
durante la edición. Nos aparece la información siguiente en pantalla. 

2. Para obtener la lista de niveles, ejecutamos el comando Ajustes → Nivel → 
Administrador. En el menú seleccionamos Niveles → Exportar… y exportamos un 
archivo que nombramos “Niveles.csv”. 

3. Importamos en archivo en Excel mediante Datos → Desde texto y cargamos el 
archivo “Niveles.csv” eligiendo como carácter de delimitación la coma. Con ello 
obtendremos una lista con la que veremos la estructura de niveles del contenido 
del archivo DGN. 

4. Para poder ver mejor las entidades tipo línea, podemos ocultar las tramas de las 
capas siguientes para poder ver el resto de capas (también las podríamos eliminar 
con Editar → Seleccionar Según Atributos): 

 9TramesRegP 

 9TramesRegA 

 7TRAEXPMPG 

 7TRAEXPPAU 

 7TRAEXPPE 

La información cartográfica proviene de distintos productores que trabajan en 
distintos formatos entre los que encontramos: 

 Archivos de CAD: DXF, DWG y DGN 

 Archivos de texto con distintos formatos 

 Archivos de Base de Datos: Access, DBase… 

 Archivos de Hoja de Cálculo 

 Archivos gráficos: Ortofotos, planos escaneados… 

 Archivos GIS: Shape, geodatabases… 

En un SIG municipal debemos interpretar e integrar esta información diversa y 
dispersa. Para ello en primer lugar debemos explorar el contenido de la 
información que nos llega en los distintos formatos. 

En este caso disponemos de un archivo DGN con la información de planeamiento, 
debemos examinar como tiene estructurada la información, tanto a nivel 
informático como conceptual.
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 7TRAEXPPP 

 9TramesVolum 

 9TramesCalif 

 3LSPR 

 5TAE 

 5TAA 

 5TAI 

5. Examinamos en contenido de las capas del archivo en Microstation siguiendo como 
guión la tabla del archivo de Excel para encontrar las entidades con la información 
que nos interesa. 

 

7.1 Importación del Planeamiento del DGN

1. En primer lugar, creamos una conexión a nuestra carpeta de trabajo con la orden 
File → Connect Folder en ArcCatalog. 

Para poder trabajar con la información en ArcGIS debemos primero importar la 
información del archivo DGN. 

Obtendremos una geodatabase que contendrá dos tipos clases de información:

 Geometría de las entidades según su tipo: Puntos (incluye las entidades 
tipo texto), líneas y polígonos.

 Información de las entidades en forma tabular: Color, tipo de línea, capa, 
etc. 
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2. En ArcCatalog, pulsamos con el botón derecho sobre “SCU_nucli_eixamplesud.dgn” 
y seleccionamos Properties. En la pestaña General seleccionamos el botón Edit y 
mostramos el cuadro de diálogo de definición de la referencia espacial con el botón 
Select. Elegimos “Projected Coordinate Systems / UTM / Other GCS / European 
Datum 1950 UTM Zone 31N.prj”. A continuación grabamos el archive .PRJ en la 
misma carpeta que el archivo DGN con el nombre que nos propone por defecto 
(SCU_nucli_eixamplesud.prj). 

3. Importamos el archivo en una Geodatabase seleccionando la herramienta 
Conversion Tools → To Geodatabase → Import from CAD en ArcToolbox. 
Arrastramos “SCU_nucli_eixamplesud.dgn” al panel Input Files y elegimos el nombre 
de la geodatabase: “Importación_DGN.gdb”. En caso de no haber definido 
anteriormente la referencia espacial la podemos seleccionar en este cuadro de 
diálogo. Nos aseguramos de no seleccionar Explode Complex Objects. Al final del 
proceso no indica que ha importado 55.176 entidades y que una entidad no se ha 
podido importar. Si hubiéramos seleccionado Explode Complex Objects nos habrían 
salido 135.709 entidades. 

4. Si nos dieran problemas las entidades complejas del DGN, podemos utilizar el 
comando de Microstation Editar → Seleccionar Según Atributos → Forma Poligonal 
Compleja y explotarlas con Separar → Separar estado complejo. 

7.2 Comprobación de la correcta georeferenciación 

1. Comprobamos que los datos estén correctamente georeferenciados. Para ello en 
ArcCatalog, en el apartado GIS Server clicamos en Add WMS Server y elegimos 
“http://shagrat.icc.es/lizardtech/iserv/ows?”. Renombramos el servidor como “ICC” 
y visualizamos la capa “Ortofoto de Catalunya 1:2.500 vigent”. 

2. En ArcMap superponemos la cartografía importada del DGN (en 
"Importación_DGN.gdb\CADStaging\Lines") a la ortofoto del ICC para comprobar 

Antes de empezar a trabajar con la cartografía importada, es esencial comprobar el 
resultado de la importación. 

La primera comprobación que haremos es la correcta georeferenciación de la 
geometría que hemos obtenido del archivo DGN. 

Para ello superpondremos las nuevas entidades con una base correctamente 
georeferenciada, en este caso con la Ortofoto del ICC (Institut Cartogràfic de 
Catalunya). 

También debemos comprobar que se han importado todas las entidades y no se 
han perdido algunas en el proceso de importación. 
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que esté correctamente georeferenciada (las coordenadas de la cartografía del ICC 
están en GCS_WGS_1984 pero ArcGIS se ocupa de la transformación). 

3. Si hemos georeferenciado correctamente la geometría nos debería aparecer una 
imagen parecida a la siguiente. 

 

7.3 Selección de la información de Planeamiento 

1. Con la capa gráfica "Importación_DGN.gdb\CADStaging\Line" cargada, cargamos la 
tabla "Importación_DGN.gdb\Entity" y vinculamos ambas clicando con el botón 

Debemos especificar las entidades que nos interesa importar y que hemos 
identificado anteriormente, a partir de las características de las entidades 
originales del DGN. 

Para vincular la información de las características de la geometría con las entidades 
geométricas debemos hacer un vínculo mediante el campo común [EntID]. 

En este caso seleccionaremos las entidades tipo línea que delimitan las 
calificaciones urbanísticas. 
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derecho en la capa Line y seleccionando Join and Relate → Join… mediante el 
campo [EntID]. Con ello conseguimos que las líneas tengan vinculada la información 
de las entidades del archivo DGN. 

2. Para ver el resultado hacemos un mapa temático por categorías donde todas las 
líneas sean de un color excepto las líneas cuyo valor del campo [Level] sea 2, a las 
cuales también asignaremos un grueso mayor de línea. 

3. En ArcCatalog creamos una File Geodatabase pulsando con el botón derecho en la 
conexión y eligiendo New → File Geodatabase con lo que creamos una 
Geodatabase llamada “SantCugat.GDB”. 

4. Una vez comprobada la importación, seleccionamos las entidades con una consulta 
por atributos (Entity.Level = 2) y exportamos la selección a la Geodatabase que 
hemos creado como "SantCugat.GDB\Planeamiento_Lineas" clicando con el botón 
derecho en la capa y seleccionando Data → Export Data… y seleccionando "Selected 
Features". 

5. En ArcCatalog, seleccionamos la Feature Class exportada y editamos los metadatos 
para describir como hemos obtenido la entidad, por ejemplo: 

 Abstract: Líneas de límite de calificación 

 Supplementary Information: Obtenidas de "SCU_nucli_eixamplesud.dgn", 
seleccionando "Level = 2" 

 … 

7.4 Importación de las etiquetas 

1. Inspeccionamos el contenido de la Tabla “Importación_DGN.gdb\Attribs” para ver 
qué campos incluye. 

2. Cargamos de la geodatabase “Importación_DGN.gdb” la capa "\CADStaging\Points" 
y la Tabla "\Attribs" (las etiquetas se importan en la geodatabase como entidades 
tipo punto). 

En el paso anterior hemos importado la delimitación de las calificaciones 
urbanísticas. 

Queremos obtener polígonos con la información de la clave de la calificación 
urbanística que corresponde a cada zona. 

La información con la clave está en entidades tipo texto que debemos importar en 
ArcGIS como paso previo de la generación de estos polígonos. 
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3. Hacemos un Join entre ellas a través el campo [EntID] seleccionando la opción 
“Keep only matching records” con lo que nos quedaremos únicamente con los 
puntos que representan etiquetas del DGN con sus atributos. 

4. Examinamos el resultado con Open Attribute Table, en el campo [AttrTag] tenemos 
los siguientes valores: 

 '9.999,99' 

 '?,??' 

 'CLAU' 

 'Nota' 

 'P00/0000' 

 'RG' 

5. Comprobamos que los que tienen el valor de 'CLAU' tienen el valor de la calificación 
en el campo [AttrStr]. Para visualizarlo, hacemos un mapa temático por categorías 
del campo [AttrTag] dónde se distingan estos valores de los del resto.  

6. Elegimos en la pestaña Label y con la opción “Define clases of features and label 
each class differently” creamos dos clases (eliminamos la clase "Default"): 

 CLAU: Con la Query Attrib.AttrTag='CLAU' 

 OTROS: Con la Query Attrib.AttrTag<>'CLAU' 

7. Seleccionamos el campo [AttrStr] en Label Field  y un color vivo y estilo bold para 
CLAU y el mismo campo pero con el texto negro para OTROS y comprobamos 
visualmente que el atributo CLAU corresponde a la Calificación Urbanística. 

8. Finalmente, una vez comprobado que es la información que nos interesa, 
seleccionamos los puntos con atributos Attrib.AttrTag = 'CLAU' y guardamos el 
resultado con el nombre “SantCugat.GDB\Planeamiento_Etiquetas”. 

9. En ArcCatalog, seleccionamos la Feature Class exportada y editamos los metadatos 
para describir como hemos obtenido la entidad. 
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7.5 Conversión a polígonos 

1. Con la herramienta de ArcToolbox Data Management Tools → Features → Feature 
To Polygon seleccionamos como Input Features la Feature Class 
“Planeamiento_Lineas" y como Label Features (optional) la Feature Class 
“Planeamiento_Etiquetas" con lo que obtenemos los polígonos de zona que 
almacenaremos en “SantCugat.GDB\Planeamiento_Poligonos”. 

2. También podemos conseguir el mismo resultado con la herramienta de ArcToolbox 
Samples → To/From CAD → Utility Models → CAD Lines to Polygon Features o bien 
asignando las etiquetas con Analysis Tools → Overlay → Spatial Join. 

7.6 Comprobación del resultado 

1. Superponemos las entidades tipo línea a los polígonos para comprobar visualmente 
que se hayan generado todos. 

2. Etiquetamos las entidades con el campo [AttrStr] y hacemos un mapa temático con 
las entidades con los valores del campo [AttrStr] sin valor con un color destacado. 

Generaremos los polígonos de calificación urbanística a partir de las entidades que 
hemos importado en los pasos anteriores. 

 Líneas que delimitan las zonas de calificación urbanística (entidades tipo 
línea) 

 Etiquetas que contienen la información de la clave de la calificación 
urbanística (entidades tipo punto) 

El serán unos polígonos (entidades tipo área) con el atributo de la clave de la 
calificación urbanística). 

Una vez obtenidos los polígonos comprobaremos que la información se ha 
importado correctamente.

Concretamente deberíamos comprobar los siguientes errores: 

 Polígonos sin atributos 

 Polígonos que no se han importado 

 Atributos que no importados correctamente 

Para ello realizaremos un etiquetado y un mapa temático para detectar posibles 
errores visualmente 
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3. Finalmente, hacemos un mapa temático por categorías de las zonas verdes (6a y 6b) 
y equipamientos (7a y 7b) utilizando la opción "Group Values" para obtener una 
mapa parecido al que aparece a continuación. 
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7.7 Ejercicio 

 

ENUNCIADO 

Hacer un mapa temático distinguiendo las claves con la calificación urbanística23, 
siguiendo el criterio del Mapa Urbanístic de Catalunya24 (MUC) para obtener un mapa 
como el de la imagen siguiente obtenida del WMS del MUC25. 

La leyenda del mapa y su codificación aparece en la página siguiente26. 

 

                                                        
23 Podemos consultar las claves en http://www.bcn.es/urbanisme/catala/qualificacions/index.htm 
24 El visor se encuentra en http://ptop.gencat.cat/muc-visor 
25 El servidor WMS del MUC es http://ptop.gencat.cat/webmap/MUC/request.aspx? 
26 Se puede encontrar la leyenda en http://ptop.gencat.cat/muc-visor/pdf/llegenda.pdf 

En el apartado anterior hemos hecho un mapa temático distinguiendo los 
equipamientos y los espacios libres. 

En el siguiente ejercicio vamos a aplicar los conocimientos adquiridos en los 
apartados anteriores para generar un mapa de calificaciones según los criterios 
establecidos por el Departament de Territori i Sostenibilitat de la Generalitat de 
Catalunya para el Mapa Urbanístic de Catalunya (MUC). 

El MUC permite hacer una lectura continua de la ordenación urbanística de 
Cataluña, resolviendo les diferencias de codificación, de lenguaje y de 
representación que tienen los distintos planes generales urbanísticos vigentes. Se 
basa en la homologación de las calificaciones de cada municipio en una única 
leyenda sintética. 

Deberemos asimilar las calificaciones urbanísticas del Plan General Metropolitano 
(PGM) a los criterios del MUC. 
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8 Trabajo con datos demográficos 

1. En ArcCatalog importamos el fichero "Unidades_Censales_2005.shp" en nuestra 
geodatabase (SantCugat.gdb) clicando con el botón derecho en el archivo Shape y 
seleccionando Export → To Geodatabase (single)… y seleccionando 
"SantCugat.gdb" como destino. 

2. Creamos con Access una base de datos llamada "Población.accdb" y renombramos 
"CAT_EDAT_SEC_2005.DAT" a "CAT_EDAT_SEC_2005.TAB" para que Access lo 
reconozca. 

3. Examinamos el archivo de texto que está estructurado de la manera siguiente: 
 ID < 1 1-2 … 98-99 >99 TOTAL 

Españoles.Hombres Sección 1       
Españoles.Mujeres Sección 1       
Españoles.Total Sección 1       
Extranjeros.Hombres Sección 1       
Extranjeros.Mujeres Sección 1       
Extranjeros.Total Sección 1       
Total.Hombres Sección 1       
Total. Mujeres Sección 1       
Total.Total Sección 1       
Españoles.Hombres …       
Españoles.Mujeres …       
Españoles.Total …       
Extranjeros.Hombres …       
Extranjeros.Mujeres …       
Extranjeros.Total …       
Total.Hombres …
Total. Mujeres …       
Total.Total …       
Españoles.Hombres Sección n       
Españoles.Mujeres Sección n       
Españoles.Total Sección n       
Extranjeros.Hombres Sección n       
Extranjeros.Mujeres Sección n       
Extranjeros.Total Sección n       
Total.Hombres Sección n
Total. Mujeres Sección n       
Total.Total Sección n       

La información demográfica con la que vamos a trabajar está contenida en un 
archivo de texto estructurado según un formato determinado que proviene del INE 
(Instituto Nacional de Estadística) según la tabla que aparece más adelante. 

Deberemos extraer la información que nos interesa, para incorporarla a ArcGIS y 
vincularla a las entidades gráficas de las Unidades Censales. 

En primer lugar prepararemos las bases de trabajo: 

 Importamos el archivo Shape con las unidades censales en la Geodatabase 

 Creamos una base de datos de Access para trabajar los datos del archivo 
de texto 
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8.1 Importación en Access y obtención de los datos estructurados 

1. En Access importamos el archivo de texto con Datos externos → Importar → 
Archivo de texto. Elegimos Tabulación como delimitador de campo y nombramos el 
primer campo como [CODIGO] (texto) y el último como [TOTALES] (entero largo) 
para obtener una tabla a la que llamaremos "POBLACIÓN" (podemos grabar los 
pasos de la importación para otros usos). 

El archivo de texto consiste una tabla donde hay secuencialmente bloques de 9 
filas con la información de cada unidad censal. Nos interesa la población total de 
cada unidad censal. 

Cada bloque de nueve filas contiene la siguiente información de cada unidad 
censal: 

 Españoles.Hombres 

 Españoles.Mujeres

 Españoles.Total 

 Extranjeros.Hombres 

 Extranjeros.Mujeres 

 Extranjeros.Total 

 Total.Hombres 

 Total. Mujeres 

 Total.Total 

Las columnas contienen la siguiente información (102 campos) separada por un 
delimitador: 

 Código de sección 

 De menos de 1 año 

 De 1 año 

 De 2 años 

 … 

 De 98 años 

 De 99 años o más 

 Total 

Por lo tanto, nos interesa de cada bloque la primera y la última columna de la 
última fila (múltiplos de 9). 
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2. Con la herramienta de Access Crear → Diseño de consulta generamos una nueva 
consulta con los campos [Id], [CODIGO] y [TOTALES], asegurándonos que el tipo de 
consulta es Seleccionar. 

3. En la definición de columnas, para el campo [Id], deseleccionamos Mostar, elegimos 
en la fila Total la opción Dónde y clicamos con el botón derecho para seleccionar 
Generar en la fila Criterios e introducimos la siguiente condición: 

Int ([POBLACION]![Id] / 9) = [POBLACION]![Id] / 9 

También podemos utilizar la siguiente expresión: 

[POBLACION]![Id] Mod 9 = 0 

En las dos columnas restantes elegimos Expresión en la fila Total. 

4. Cambiamos a la vista tabla con Ver → Vista de Hoja de datos para inspeccionar el 
resultado. La consulta en la vista SQL (Ver → Vista SQL) es el siguiente: 

5. Seleccionamos nuevamente la Vista Hoja de datos para ver el resultado. Grabamos 
la consulta con el nombre "POBLACION_TOTAL" y exportamos esta tabla en un 
archivo DBF con Datos externos → Exportar → Más → Archivo dBase para obtener 
el archivo "POBLACION_TOTAL.DBF". 

8.2 Importación de la información de Access en ArcGIS 

1. En ArcGIS creamos un nuevo campo de texto de 10 caracteres que llamamos 
[CODIGO] y lo rellenamos con la expresión siguiente: 

[PROVMUN] & [DISTRITO] & [SECCION] 

2. Hacemos un Join de "Unidades_Censales_2005" con "POBLACION_TOTAL.DBF". 

3. Hacemos un mapa temático de la densidad de población. Las secciones censales de 
Sant Cugat corresponden a: Unidades_Censales_2005.PROVMUN = '08205'. 

SELECT POBLACION.CODIGO, POBLACION.TOTALES

FROM POBLACION

WHERE ((Int([POBLACION]![Id]/9)=[POBLACION]![Id]/9));

Para poder realizar el mapa temático de densidad de población, debemos vincular 
la información obtenida con las bases gráficas a través del código de unidad 
central. 

Tendremos que construir el código de unidad central en ArcGIS mediante la 
concatenación de códigos de Provincia, Distrito y Sección. 
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8.3 Trabajo con la información del Padrón 

1. Importamos un archivo DBF27 con el número de habitantes por parcela28 
(Padron_ParcelaCatastral.dbf) en nuestra Geodatabase y lo vinculamos con la capa 
de parcelas (Fincas_Ambito) a través de la referencia catastral que deberemos 
generar con la expresión siguiente: 

[REFCAD] = [MASA] & [PARCELA] & [HOJA] 

                                                        
27 ArcGIS no puede modificar la estructura de las tablas en formato DBF 
28 Los datos se han alterado para proteger el secreto estadístico 

Finalmente, para tener un mayor nivel de desagregación de la información 
demográfica, trabajaremos con la información del Padrón, vinculándola con la 
cartografía Catastral pera poder hacer un mapa temático a nivel de parcela. 
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2. Para trabajar con la Geodatabase de Catastro (Catastro_AMBITO.gdb) primero 
debemos descomprimirla con Data Management Tools → File Geodatabase → 
Uncompress file Geodatabase data. 

3. Con el resultado de la vinculación generamos un mapa con la densidad de 
habitantes por parcela. 
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9 Contenido de las Bases Catastrales 

Todas las bases catastrales se encuentran en una geodatabase29 llamada 
"Catastro_AMBITO.gdb". 

9.1 Capas gráficas 

Las capas gráficas del Catastro con las que trabajaremos son: 

 MASA_AMBITO: Manzanas urbanas y polígonos rústicos. 

 PARCELA_AMBITO: Parcelas catastrales. 

 CONSTRU_AMBITO: Construcciones urbanas. 

Las capas gráficas contienen los campos [HOJA], [MASA] y [PARCELA]. Se puede 
construir la referencia catastral de la parcela con la siguiente fórmula:  

[REFCAD] = [MASA] & [PARCELA] & [HOJA] 

En la capa "CONSTRU_AMBITO" también hay el campo [CONSTRU] con la altura del 
elemento volumétrico. 

Debemos tener en cuenta que: CONSTRU ⊂ PARCELA ⊂ MASA 

9.2 Tablas alfanuméricas 

Las bases alfanuméricas del Catastro30 con las que trabajaremos son: 

 FINCA: Registro de Finca. Existirá uno por cada parcela catastral implicada. 

 UNIDAD_CONSTRUCTIVA: Registro de Unidad Constructiva. Existirá uno por 
cada unidad constructiva en cada parcela catastral. 

 CONSTRUCCION: Registro de Construcción. Existirá uno por cada construcción 
de cada unidad constructiva en cada parcela catastral. 

Debemos tener en cuenta que: CONSTRUCCION ⊂ UNIDAD_CONSTRUCTIVA ⊂ FINCA 

A) Tabla Finca 

La tabla FINCA (asimilable a parcela) contiene los siguientes campos: 

 [REFCAD]: Referencia catastral de la parcela. 

 [SUPFINCA]: Superficie de suelo de la parcela. 

 [SUPCONSTT]: Superficie construida total (sobre rasante y bajo rasante) en la 
parcela. 

                                                        
29 Si no lo hemos hecho, debemos descomprimir la geodatabase para trabajar con ella 
30 Se puede encontrar la descripción de los campos en el archivo "catastro_fin_2006.pdf" 
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 [SUPCONSTSR]: Superficie construida sobre rasante en la parcela. 

 [SUPCONSTST]: Superficie construida bajo rasante en la parcela. 

 [SUPCOBERT]: Superficie de la proyección horizontal de la cubierta. 

B) Tabla Unidad Constructiva 

La tabla UNIDAD_CONSTRUCTIVA (asimilable a edificio en parcela) contiene los 
siguientes campos: 

 [REFCAD]: Referencia catastral de la parcela a la que pertenece. 

 [CODIUC]: Código de la unidad constructiva. 

 [ANYCONST]: Año de construcción del edificio. 

La referencia de la unidad constructiva se construiría mediante la siguiente fórmula: 

[REFEDIFICIO] = [REFCAD] & [CODIUC] 

C) Tabla Construcción 

La tabla CONSTRUCCION (asimilable a local en edificio) contiene los siguientes campos: 

 [REFCAD]: Referencia catastral de la parcela a la que pertenece el local. 

 [NUMORDRE]: Identificador del local dentro de la unidad constructiva. 

 [CODIUC]: Código de la unidad constructiva a la que pertenece. 

 [PLANTA]: Planta dentro de la cual está el local. 

 [SUPLOCAL]: Superficie del local. 

 [UCM]: Código según la tabla adjunta de tipologías constructivas. 

 [CATEG]: Calidad constructiva. 

La referencia de la construcción se construiría mediante la siguiente fórmula: 

[REFLOCAL] = [REFCAD] & [CODIUC] & [NUMORDRE] 

D) Obtención de la referencia del local 

Si quisiéramos generar la referencia del local, debemos poner en formato texto el 
campo numérico [NUMORDRE], con la siguiente expresión en el Field Calculator 
(grabar el texto como Formato.cal)31. 

                                                        
31 Código obtenido del archivo "field_String_To_ConstantLengthString2.cal" de http://www.ian-ko.com 
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Dim sOriginal As String

Dim sFill As String

Dim sNew As String

Dim lStringLength As Long

lStringLength = 4

sFill = "000000000000000000"

sOriginal = CStr([NUMORDRE])

sNew = Right(sFill & sOriginal, lStringLength)

__esri_field_calculator_splitter__

sNew
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10 Obtención de la antigüedad media por parcela a partir de las Bases 
Catastrales 

Una parcela que contiene dos edificios (A y B), de antigüedad 1950 y 1990 
respectivamente. Estos edificios contienen los siguientes locales: 

EDIFICIO A (1950) 

LOCAL Sup. 
Construida 

Local A1 100 m2 

Local A2 150 m2 

TOTAL 250 m2 

 

EDIFICIO B (1990) 

LOCAL Sup. 
Construida 

Local B1 200 m2 

Local B2 100 m2 

Local B3 400 m2 

TOTAL 700 m2 

Por lo tanto, la antigüedad de la parcela seria en este ejemplo: 

250 ∙ 1950 + 700 ∙ 1990
250 + 700 = 1979,47 

El valor está más próximo a 1990 que  a 1950 puesto que este edificio tiene mayor 
superficie construida. 

10.1 Obtención de la superficie construida de cada edificio 

Queremos obtener un valor de antigüedad de la edificación por parcela (año de 
construcción). 

La base catastral de parcela (gráfica) no contiene ningún campo con el año de 
construcción. La información del año de construcción se encuentra en la base 
catastral de unidad constructiva (tabular), por lo tanto debemos trasladar esta 
información a la parcela. 

Las parcelas pueden contener múltiples unidades constructivas, por lo tanto, para 
asignar el valor de año de construcción a la parcela debemos hacer algún tipo de 
aproximación. 

El criterio que seguiremos es asignar el valor de año de construcción de cada 
unidad constructiva ponderándolo en función de su superficie construida respecto 
al total de superficie construida total de la parcela. 

En primer lugar debemos obtener la superficie construida de cada unidad 
constructiva (edificio) a partir de las construcciones (locales) que la componen para 
poder realizar la ponderación por superficie. 
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1. En la tabla "CONSTRUCCION" debemos obtener la referencia de la unidad 
constructiva construyéndola mediante la siguiente fórmula en un nuevo campo de 
texto, que debemos dimensionar adecuadamente: 

[REFCONS] = [REFCAD] & [CODIUC] 

2. Obtendremos la superficie construida por unidad constructiva de la tabla 
"CONSTRUCCION" con el comando Analysis Tools → Statistics → Summary Statistics 
con los siguientes parámetros: 

 Input Table: "Construccion" 

 Output Table: "Construccion_SUP_UnidadConstructiva" 

 Statistics Field: [SUPLOCAL] 

 Statistic Type: [SUM] 

 Case Field: [REFCONS] 

En el campo [FREQUENCY] obtendremos el número de casos (número de 
construcciones por unidad constructiva) y en el campo [SUM_SUPLOCAL] la suma 
de la superficie construida de los locales de la unidad constructiva. 

3. Para vincular la información agregada, haremos un Join entre 
"Unidad_Constructiva" y "Construccion_SUP_UnidadConstructiva" a través del 
campo [REFCONS] (es posible que se pierdan algunos valores). 

4. Comprobamos que la agrupación se ha realizado correctamente realizando el 
cálculo de manera manual para algunas unidades constructivas. 

10.2 Obtención de la superficie construida de cada parcela 

En segundo lugar debemos obtener la superficie construida de cada parcela a partir 
de las unidades constructivas (edificios) que la componen para poder realizar la 
ponderación por superficie. 

La capa parcelas contiene un valor de superficie construida, sin embargo, lo 
calcularemos a partir de las construcciones que contiene puesto que esta 
información es más fiable. 

Adicionalmente, como calculamos la agregación a nivel de construcción y de 
parcela a partir de la misma información, los resultados serán coherentes. 
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1. Obtenemos también la superficie construida de los locales de cada Parcela con el 
mismo procedimiento que hemos utilizado anteriormente con los siguientes 
parámetros32: 

 Input Table: "Construccion" 

 Output Table: "Construccion_SUP_Finca" 

 Statistics Field: [SUPLOCAL] 

 Statistic Type: [SUM] 

 Case Field: [REFCAD] 

2. Para vincular la información agregada, haremos un Join entre 
"Unidad_Constructiva" y "Construccion_SUP_Finca" a través del campo [REFCONS] 
(es posible que se pierdan algunos valores). 

3. Finalmente, Comprobamos que la agrupación se ha realizado correctamente 
realizando el cálculo de manera manual para algunas fincas. 

10.3 Cálculo del año de construcción por parcela 

 
1. Tenemos vinculadas de los apartados anteriores las nuevas tablas con la tabla 

"Unidad_Constructiva": 

 "Construccion_SUP_Finca" 

 "Construccion_SUP_UnidadConstructiva" 

2. Creamos en la tabla "Unidad_Constructiva" un campo nuevo al que llamaremos 
[ANO_POND] donde pondremos el producto del año de construcción por la suma de 
las superficies construidas de las construcciones de la unidad constructiva partido 
por la suma de las superficies construidas de las construcciones de toda la finca33. 

 

                                                        
32 También podemos hacer la agrupación con la tabla obtenida anteriormente. 
33 Aplicando la propiedad distributiva 

∑ 𝐴ñ𝑜𝑛𝑛
1 × 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 𝑆𝑜𝑐𝑐𝑐𝑆𝑆𝑆𝑐𝑐𝑛

∑ 𝑆𝑆𝑆𝑆𝑆𝑆í𝑆𝑆𝑐 𝑆𝑜𝑐𝑐𝑐𝑆𝑆𝑆𝑐𝑐𝑐𝑐𝑆 𝑆𝑐𝑐𝑐 𝑆𝑐𝑆𝑐𝑐𝑐 𝑆𝑜𝑐𝑐𝑐𝑆𝑆𝑆𝑐𝑆𝑐𝑐 

Finalmente, obtendremos la media ponderada del año de construcción por 
superficie de las unidades constructivas (edificios) que hay en cada finca (parcela). 

Para calcular en año de construcción ponderado por parcela, utilizaremos la 
siguiente fórmula: 
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[Unidad_Constructiva. ANYCONST] × [Construccion_SUP_UC. SUM_SUPLOCAL]
[Construccion_SUP_Finca. SUM_SUPLOCAL]  

 

3. Finalmente agrupamos [ANO_POND] por [REFCAD] para obtener la media 
ponderada del año de construcción de las edificaciones de la finca para cada finca). 

 Input Table: "Unidad_Constructiva" (más las dos tablas vinculadas) 

 Output Table: "Fincas_Antiguedad" 

 Statistics Field: [ANO_POND] 

 Statistic Type: [SUM] 

 Case Field: [REFCAD] 

4. Comprobamos que se haya calculado bien eligiendo un registro cuyos edificios sean 
todos de la misma fecha de construcción y comprobando que la fecha no ha 
variado. También realizamos el cálculo con algunos registros elegidos al azar. 

5. Vinculamos la tabla obtenida34 (Fincas_Antiguedad) a la capa "PARCELA_AMBITO". 
A continuación realizamos el mapa temático de los años de construcción, marcando 
en rojo las entidades sin valores. 

10.4 Método de cálculo a nivel de local 

Es posible también realizar el cálculo trabajando sólo a nivel de construcción. 

Para ello deberemos incorporar a la tabla construcción el año de construcción de la 
unidad constructiva y añadir una columna con el producto de la superficie por el año. 

Parcela 

LOCAL Sup. 
Construida 

Año Producto 

Local A1 100 m2 1950 195000 

Local A2 150 m2 1950 292500 

Local B1 200 m2 1990 398000 

Local B2 100 m2 1990 199000 

Local B3 400 m2 1990 796000 

TOTAL 950 m2  1880500 

 

                                                        
34 Una vez hechos los cálculos podemos eliminar las tablas y los campos intermedios i documentar el 
proceso seguido en los metadatos de la tabla. 
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En este caso la antigüedad calculada por parcela es la división entre los dos sumatorios 
de superficie construida y del producto calculado: 950 / 1880500 = 1979,47. 
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11 Trabajo con Bases Catastrales 

En el presente ejercicio trabajaremos tan sólo una parte de la información de estas 
bases para obtener el potencial de techo comercial existente en las plantas bajas de las 
parcelas con frente a las calles designadas como de prioridad comercial. 

Dicho de otra manera, queremos conocer la cantidad de techo de uso no comercial 
que cumpla las condiciones (en planta baja y frente a una calle de prioridad comercial) 
que puede transformarse en comercial. 

Para ello disponemos de las bases catastrales y el archivo DGN con el que hemos 
trabajado (SCU_nucli_eixamplesud.dgn). 

11.1 Interpretación de los códigos UCM 

  

Las bases de información del Catastro contienen una gran cantidad de información, 
tanto gráfica cómo alfanumérica. 

Puesto que la finalidad de estas bases es la valoración de los inmuebles a efectos 
fiscales, su contenido es desigual tanto en la calidad de la información como en su 
actualización. 

Como contrapartida, las bases Catastrales son relativamente homogéneas en el 
territorio y permiten trabajarlas con la misma metodología en distintos puntos del 
territorio. 

En las bases catastrales encontraremos el uso almacenado como códigos UCM 
(Uso, Clase y Modalidad) con un código de 4 dígitos resultado de la siguiente 
concatenación: 

 Los primeros dos dígitos corresponden al uso (del 1 al 10) 

 El tercer dígito corresponde a la clase 

 El cuarto dígito corresponde al uso 

Los códigos están en la tabla de Unidades Constructivas. 

En la tabla siguiente aparece el significado de cada uno de los códigos. 

Como alternativa, también se puede utilizar la codificación de los usos de los bienes 
inmuebles, cuya tabla se puede consultar a continuación de la primera tabla. 
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TIPOLOGÍAS CONSTRUCTIVAS 

USO CLASE MODALIDAD 

1 RESIDENCIAL 1.1 VIVIENDAS COLECTIVAS DE 
CARÁCTER URBANO 

1.1.1 EDIFICACIÓN ABIERTA 

1.1.2 EN MANZANA CERRADA 

1.1.3 GARAJES, TRASTEROS Y LOCALES 
EN ESTRUCTURA 

1.2 VIVIENDAS UNIFAMILIARES DE 
CARÁCTER URBANO 

1.2.1 EDIFICACIÓN AISLADA O PAREADA 

1.2.2 EN LÍNEA O MANZANA CERRADA 

1.2.3 GARAJES Y PORCHES EN PLANTA 
BAJA 

1.3 EDIFICACIÓN RURAL 1.3.1 USO EXCLUSIVO DE VIVIENDA 

1.3.2 ANEXOS 

2 INDUSTRIAL 2.1 NAVE DE FABRICACIÓN Y 
ALMACENAMIENTO 

2.1.1 FABRICACIÓN EN UNA PLANTA 

2.1.2 FABRICACIÓN EN VARIAS PLANTAS 

2.1.3 ALMACENAMIENTO 

2.2 GARAJES Y APARCAMIENTOS 2.2.1 GARAJES 

2.2.2 APARCAMIENTOS 

2.3 SERVICIOS DE TRANSPORTE 2.3.1 ESTACIONES DE SERVICIO 

2.3.2 ESTACIONES 

3 OFICINAS 3.1 EDIFICIO EXCLUSIVO 3.1.1 OFICINAS MÚLTIPLES 

3.1.2 OFICINAS UNITARIAS 

3.2 EDIFICIO MIXTO 3.2.1 UNIDO A VIVIENDAS 

3.2.2 UNIDO A INDUSTRIA 

3.3 BANCA Y SEGUROS 3.3.1 EN EDIFICIO EXCLUSIVO 

3.3.1 EN EDIFICIO MIXTO 

4 COMERCIAL 4.1 COMERCIOS EN EDIFICIO MIXTO 4.1.1 LOCALES COMERCIALES Y 
TALLERES 

4.1.2 GALERÍAS COMERCIALES 

4.2 COMERCIOS EN EDIFICIO 
EXCLUSIVO 

4.2.1 EN UNA PLANTA 

4.2.2 EN VARIAS PLANTAS 

4.3 MERCADOS Y SUPERMERCADOS 4.3.1 MERCADOS 

4.3.2 HIPERMERCADOS Y 
SUPERMERCADOS 

5 DEPORTES 5.1 CUBIERTOS 5.1.1 DEPORTES VARIOS 

5.2 DESCUBIERTOS 5.2.2 PISCINAS 

5.2.1 DEPORTES VARIOS 

5.2.2 PISCINAS 

5.3 AUXILIARES 5.3.1 VESTUARIOS, DEPURADORAS, 
CALEFACCIÓN, etc. 

5.4 ESPECTÁCULOS DEPORTIVOS 5.4.1 ESTADIOS, PLAZAS DE TOROS 

5.4.2 HIPÓDROMOS, CANÓDROMOS, 
VELÓDROMOS, etc. 
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6 ESPECTÁCULOS 6.1 VARIOS 6.1.1 CUBIERTOS 

6.1.2 DESCUBIERTOS 

6.2 BARES MUSICALES SALAS DE 
FIESTAS DISCOTECAS 

6.2.1 EN EDIFICIO EXCLUSIVO 

6.2.2 UNIDO A OTROS USOS 

6.3 CINES Y TEATROS 6.3.1 CINES 

6.3.2 TEATROS 

7 OCIO Y HOSTELERÍA 7.1 CON RESIDENCIA 7.1.1 HOTELES, HOSTALES, MOTELES 

7.1.2 APARTAHOTELES, BUNGALOWS 

7.2 SIN RESIDENCIA 7.2.1 RESTAURANTES 

7.2.2 BARES Y CAFETERÍAS 

7.3 EXPOSICIONES Y REUNIONES 7.3.1 CASINOS Y CLUBS SOCIALES 

7.3.2 EXPOSICIONES Y CONGRESOS 

8 SANIDAD Y BENEFICENCIA 8.1 SANITARIOS CON CAMAS 8.1.1SANATORIOS Y CLÍNICAS 

8.1.2 HOSPITALES 

8.2 SANITARIOS VARIOS 8.2.1 AMBULATORIOS Y CONSULTORIOS 

8.2.2 BALNEARIOS, CASAS DE BAÑOS 

8.3 BENÉFICOS Y ASISTENCIA 8.3.1 CON RESIDENCIA (Asilos, 
Residencias, etc.) 

8.3.2 SIN RESIDENCIA (Comedores, 
Clubs, Guarderías, etc.) 

9 CULTURALES Y RELIGIOSOS 9.1 CULTURALES CON RESIDENCIA 9.1.1 INTERNADOS 

9.1.2 COLEGIOS MAYORES 

9.2 CULTURALES SIN RESIDENCIA 9.2.1 FACULTADES, COLEGIOS, 
ESCUELAS 

9.2.2 BIBLIOTECAS Y MUSEOS 

9.3 RELIGIOSOS 9.3.1 CONVENTOS Y CENTROS 
PARROQUIALES 

9.3.2 IGLESIAS Y CAPILLAS 

10 EDIFICIOS SINGULARES 10.1 HISTÓRICO-ARTÍSTICOS 10.1.1 MONUMENTALES 

10.1.2 AMBIENTALES O TÍPICOS 

10.2 DE CARÁCTER OFICIAL 10.2.1 ADMINISTRATIVOS 

10.2.2 REPRESENTATIVOS 

10.3 DE CARÁCTER ESPECIAL 10.3.1 PENITENCIARIOS, MILITARES Y 
VARIOS 

10.3.2 OBRAS URBANIZACIÓN INTERIOR 

10.3.3 CAMPINGS 

10.3.4 CAMPOS DE GOLF 

10.3.5 JARDINERÍA 

10.3.6 SILOS Y DEPÓSITOS PARA 
SOLIDOS (M/3) 

10.3.7 DEPÓSITOS LÍQUIDOS (M/3) 

10.3.8 DEPÓSITOS GASES (M/3) 
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CODIFICACIÓN DE LOS USOS DE LOS BIENES INMUEBLES 

CÓDIGO USO 

A Almacén -Estacionamiento 

V Residencial 

I Industrial 

O Oficinas 

C Comercial 

K Deportivo 

T Espectáculos 

G Ocio y Hostelería 

Y Sanidad y Beneficencia 

E Cultural 

R Religioso 

M Obras de urbanización y jardinería, suelos sin edificar 

P Edificio singular 

B Almacén agrario 

J Industrial agrario 

Z Agrario 
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11.2 Trabajo con el contenido de las Bases Catastrales 

1. Para seleccionar las actividades comerciales en planta baja debemos seleccionar y 
exportar los locales que cumplan la siguiente condición35 con una búsqueda por 
atributos en la tabla de construcciones: 

"UCM" LIKE '04%' and "PLANTA" = '00' 

2. Para seleccionar todos los locales en planta baja (independientemente de su uso) 
debemos seleccionar las que cumplan la siguiente condición: 

"PLANTA" = '00' 

3. Almacenamos ambas consultas como tablas y obtenemos la suma de la superficie 
construida agrupada36 por parcela a partir de estas dos tablas con la herramienta 
Analysis Tools → Statistics → Summary Statistics. 

4. Finalmente vinculamos los dos resultados de la agrupación por parcela con la capa 
gráfica de fincas a través del campo común de Referencia Catastral de la finca. Con 
ello obtenemos dos nuevos campos en la capa de fincas con los valores de 
superficie construida en planta baja de uso comercial y de superficie total en planta 
baja. 

 

 

 

                                                        
35 Wildcards: '%' es el equivalente de '*' en MS-DOS y '_' es el equivalente de '?' 
36 Debemos tener en cuenta que la agregación es una operación que se efectúa en una sola dirección 
(de más desagregado a menos desagregado) y no se puede revertir. 

Debemos seleccionar las construcciones en planta baja de uso no residencial para 
posteriormente filtrar las que tienen frente a las calles designadas como de 
prioridad comercial. 

 Utilizaremos el campo con la codificación UCM para seleccionar las 
construcciones no residenciales. 

 Utilizaremos el valor del campo PLANTA para distinguir la planta dónde se 
ubican las construcciones. 

Queremos obtener dos valores de superficie construida agrupada a nivel de parcela 
(la información se encuentra en la tabla alfanumérica de construcciones): 

 Superficie construida en planta baja 

 Superficie construida en planta baja de uso comercial 
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11.3 Obtención de las calles con prioridad comercial 

1. Para obtener la delimitación de la zona, buscamos en el Registre de Planejament 
Urbanístic de Catalunya37 (RPUC) el expediente del municipio de Sant Cugat del 
Vallès (comarca del Vallès Occidental) buscando la cadena de texto "nucli" con lo 
que obtendremos el expediente 2005/020234/B (Modificació puntual de la 
normativa del Pla general metropolità en l'àmbit del nucli antic). 

2. Nos descargamos la documentación en PDF del "Text Refós de la Modificació 
Puntual de la Normativa del Pla General Metropolità per a afavorir la implantació de 
l'ús comercial a l'àmbit del Nucli Antic i proximitats del Municipi de Sant Cugat del 
Vallès". 

3. En el archivo DGN (SCU_nucli_eixamplesud.dgn) visualizamos únicamente las 
siguientes capas: 

 [7TNEXP] 

 [7TNEXPC] 

 [7PEXP] 

4. Comprobamos que las entidades de la capa con los polígonos de los ámbitos de 
planeamiento [7PEXP] se superponen y que por lo tanto no podemos importarlas 
automáticamente con sus atributos38. 

5. Con el Administrador de Niveles creamos una nueva capa con el nombre 
[PEATONAL].

6. Con Editar → Buscar/Reemplazar texto buscamos el texto "20234" seleccionando 5 
como Factor de zoom. Una vez localizada la entidad, la movemos a la capa 
[PEATONAL] y guardamos los cambios (debemos previamente desbloquear la 
entidad con Editar → Desbloquear). 

                                                        
37 http://ptop.gencat.cat/rpucportal/ 
38 Si las importáramos, no nos sería posible determinar sin ambigüedades a cuál de las entidades 
superpuestas corresponde la etiqueta. 

Para poder seleccionar las parcelas que dan frente a las calles con prioridad 
comercial, en primer lugar debemos obtener la geometría de estas calles. 

Para ello consultaremos la información de planeamiento para averiguar el 
expediente que corresponde a la determinación de las calles de prioridad 
comercial.

A continuación, conociendo la referencia del expediente podremos identificar la 
entidad gráfica que delimita las calles comerciales en el DGN. 



Pilar Garcia Almirall, Francesc Valls Dalmau y Montse Moix Bergadà  

SIG en la Gestión de la Información Urbanística en el ámbito local  65 

7. Exportamos el archivo a DXF y lo importamos como hemos hecho en anteriores 
ocasiones, seleccionando Explode Complex Objects, y comprobando que se nos 
importa en la ubicación correcta. Finalmente lo convertimos en polígonos con Data 
Management Tools → Features → Feature To Polygon y lo almacenamos en nuestra 
geodatabase, borrando los polígonos que se han generado en los huecos. 

11.4 Obtención de resultados 

1. Teniendo en cuenta la escala del parcelario, seleccionamos con una tolerancia39 de 
0,5 metros las parcelas con frente a la calle con la orden Select By Location y 
eligiendo que seleccione las entidades de la capa Parcelas que intersecan la capa 
Peatonal, eligiendo el valor de 0,5 metros en la opción Apply a buffer to the features 
in. 

2. Creamos un mapa temático con la diferencia entre la superficie construida total y la 
superficie construida dedicada a comercial en planta baja (por parcela). 

3. Para que nos considere los valores nulos como ceros, utilizaremos expresión 
siguiente en el preprocesador para el cálculo de la diferencia. Con ello 
conseguiremos que antes de evaluar la diferencia nos sustituya los valores que son 
nulos por cero. 

Aunque en general no es correcto asumir que nos valores nulos son cero (según la 
lógica trivalente establecida por E. F. Codd) en este caso asumiremos que es 
correcto pues evaluamos el caso más desfavorable. 

                                                        
39 Teniendo en cuenta que la escala nominal del mapa es 1:1000 y que la resolución es de 0,5 mm 

Queremos obtener un mapa temático de las parcelas que dan frente a las calles de 
prioridad comercial donde se muestren: 

 La diferencia entre la superficie construida total y la superficie construida 
dedicada a uso comercial (potencial de techo) 

 El porcentaje de superficie construida dedicada a comercial en planta baja 
respecto a la superficie construida total en plata baja (porcentaje de techo 
comercial) 

Utilizaremos los datos que hemos preparado en los apartados anteriores: 

 Geometría de las calles con prioridad comercial 

 Superficie construida por parcela: Superficie total y superficie de uso 
comercial 
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4. Siguiendo el procedimiento explicado en el apartado anterior, creamos otro mapa 
temático con el porcentaje de superficie dedicada a uso comercial respecto al total 
en planta baja (por parcela). 

 

5. Finalmente, calculamos el valor del techo total en metros cuadrados que se podría 
transformar de otros usos a comercial para las parcelas estudiadas en planta baja. 

  

Dim Comercial As Double

Dim Total As Double

If isNull ( [SUP_PB_COMERCIAL] ) = True Then

Comercial=0

Else Comercial= [SUP_PB_COMERCIAL] 

EndIf 

If isNull ( [SUP_PB_TOTAL] ) = True Then

Total=0

 Else Total= [SUP_PB_TOTAL] 

EndIf 

__esri_field_calculator_splitter__

Total - Comercial
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11.5 Ejercicio: Análisis del uso residencial 

 

ENUNCIADO 

Calcular i crear un mapa temático con el porcentaje de superficie construida para el 
uso residencial respecto a la total en todo ámbito de estudio, exceptuando las plantas 
bajas de las calles de prioridad comercial. 

En este ejercicio utilizaremos los conocimientos adquiridos hasta ahora para 
averiguar si el uso residencial del ámbito de estudio es el dominante en las plantas 
piso (entendiendo estas como las plantas sobre rasante distintas de la planta baja).
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12 Cálculo del Potencial Urbanístico del ámbito de estudio 

Debemos tener en cuenta que nos podemos encontrar el caso de una parcela que sea 
simultáneamente sobreedificada y subedificada. Por ejemplo en el caso que describe 
el dibujo siguiente tenemos: 

 Según el planeamiento (en rojo), podemos edificar una altura de tres plantas 
en el frente de calle mientras que el patio interior de manzana es no 
edificable 

 En la parcela azul, la volumetría construida consiste en dos plantas edificadas 
en el frente de calle coincidiendo con la profundidad edificable y una 
construcción al fondo de la parcela (en el patio de manzana) 

 

Queremos obtener el techo no materializado de la zona de estudio, entendiendo 
éste como el techo que es posible edificar según el planeamiento vigente y que sin 
embargo las construcciones actuales afectadas por este planeamiento no han 
edificado. 

Este cálculo se hará a partir de la comparación de dos tipos de información: 

 La información de planeamiento, que determina la volumetría máxima 
edificable 

 La información de volumetría del catastro, que nos proporciona, aunque 
con inexactitudes, información del estado actual de las edificaciones 

Utilizaremos la información gráfica puesto que una parcela tendrá un volumen 
subedificado o sobreedificado en función de dónde esté ubicado este volumen en 
relación con la volumetría que admite el planeamiento. 
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En este caso la parcela esta subedificada en la parte de la construcción con frente a la 
calle y sobreedificada  en la parte construida en el fondo de la parcela. 

Debemos contabilizar independientemente ambos casos (sobreedificación y 
subedificación) puesto que no podemos compensar ambas superficies. 

Para simplificar el estudio no tendremos en cuenta algunos aspectos: 

 No consideramos ni la alturas reguladoras del planeamiento, tan solo 
consideramos el número de plantas 

 No evaluamos las alturas de las plantas del edificio construido, tan solo 
consideramos también el número de plantas 

 No tenemos en cuenta la posibilidad de edificar altillos según el planeamiento 

 No tenemos consideramos la posibilidad de edificar la planta bajocubierta 

 Consideramos los patios de ventilación como un volumen no edificado, 
cuando deberían considerarse superficie construida 

 Consideramos las cajas de escalera salientes en cubierta como volumen 
edificado, cuando no deberían contabilizarse a efectos de superficie 
construida 

12.1 Importación de las alturas máximas del planeamiento 

1. Siguiendo el mismo procedimiento descrito en el apartado 0, importaremos las 
entidades dentro del ámbito de estudio de la Layer [9TramesVolum] (entidades tipo 
Área) y las etiquetas de la Layer [6TNUP] (entidades tipo punto) y las convertiremos 

Debemos obtener la altura máxima de las edificaciones según el Planeamiento para 
poder compararlas con la altura edificada actual.

Necesitaremos la siguiente información: 

 La geometría de la zona edificable 

 El número de plantas que corresponden a cada zona edificable 

En el caso de la zona de estudio, toda la edificación está regulada según alineación 
de vial, de forma que podemos disponer la delimitación la zona edificable 
importando la geometría correspondiente del DGN (en caso de existir en el ámbito 
de estudio zonas otras claves como por ejemplo de volumetría específica no 
podríamos hacerlo). En el caso de los equipamientos, no consideraremos su 
potencial urbanístico. 

También deberemos importar el número que nos indica el número de plantas 
edificables, que encontraremos en forma de etiqueta en el DGN. 
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en entidades con atributos en ArcGIS, almacenándolas en la geodatabase de trabajo 
(SantCugat.GDB) como "Altura_Maxima". 

2. Puede ser necesario ejecutar la orden Data Management Tools → Features → Check 
Geometry para comprobar la cartografía importada de [9TramesVolum] y  a 
continuación Data Management Tools → Features → Repair Geometry para 
corregirla. 

3. Una vez importada la cartografía, haremos un mapa temático y etiquetaremos las 
entidades con el campo [RefName]. Debemos corregir manualmente los errores que 
detectemos comparando con el DGN para generar un mapa parecido al del ejemplo 
siguiente (prestaremos atención a las líneas de las capas [6LCAL] y [6LFE] y la línea 
de fachada40). 

 

4. Finalmente, fusionaremos las entidades con la misma altura con la orden Data 
Management → Generalization → Dissolve utilizando el campo [RefName] y 
deseleccionando Create multipart features para que nos una únicamente los 
polígonos contiguos. 

  

                                                        
40 Si queremos obtener la fachada debemos utilizar la herramienta de ArcToolbox Data Management 
Tools > Generalization > Dissolve y deseleccionar Create multipart features. 
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12.2 Obtención de la volumetría de la cartografía de Catastro 

1. Examinamos el campo [Constru] de la capa "CONSTRU_AMBITO" y comprobamos 
que contiene la altura del elemento que describe la geometría. 

2. Queremos obtener una tabla como la siguiente que nos permita traducir la 
información de las bases catastrales a número de plantas sobre rasante y número 
de plantas bajo rasante. 

CÓDIGO SOBRE RASANTE BAJO RASANTE 

I 1 0

-I 0 1

-I+I 1 1

-I+II 2 1

-I+III 3 1

II 2 0

III 3 0

IV 4 0

P 0 0

POR 0 0

… … … 

 

3. Para obtener todos los valores de códigos que aparecen en el ámbito (la primera 
columna de la tabla anterior), abrimos la capa como tabla y hacemos clic en el 
campo [Constru] con el botón derecho; seleccionamos Summarize… para obtener la 
tabla que denominaremos "Constru_Cuenta". 

4. Añadimos los dos siguientes campos a la tabla "Constru_Cuenta": 

 [PLANTAS_BR]: Plantas Bajo Rasante 

 [PLANTAS_SR]: Plantas Sobre Rasante 

Debemos obtener el número de plantas de los edificios a partir de la cartografía de 
catastro. 

En la base de datos que utilizaremos, la codificación de la altura no se almacena 
como un número sino con otro tipo de codificación. Esta codificación nos da una 
información de mayor riqueza pero nos obliga hacer algunos pasos intermedios 
para poder utilizarla para calcular el potencial urbanístico. 
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5. Asignaremos los valores de altura a estos dos campos teniendo en cuenta que la 
nomenclatura del campo [Constru] de la capa "CONSTRU_AMBITO" es la de la 
siguiente tabla: 

CÓDIGO DESCRIPCIÓN 

-I, -II Volúmenes bajo rasante  (1, 2 alturas) 

I, II Volúmenes sobre rasante (1, 2 alturas) 

B Balcón 

T Tribuna (balcón techado) 

TZA Terraza 

POR Porche 

SOP Soportal 

PJE Pasaje 

MAR Marquesina 

P Patio 

CO Cobertizo 

EPT Entreplanta 

SS Semisótano 

ALT Altillo 

PI Piscina 

TEN Pista de tenis 

ETQ Estanque 

SILO Silo 

SOLAR Solar 

PRG Pérgola 

DEP Depósito 

ESC Escalera 

TRF Transformador 

GON Góndola 

JD Jardín 

FUT Campo de fútbol 

VOL Voladizo 

ZD Zona Deportiva 

RUINA Ruinas 

CONS En construcción 
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6. Finalmente, vinculamos el archivo obtenido a la capa "CONSTRU_AMBITO" a través 
del campo [CONSTRU] con lo que incorporamos la información del número de 
plantas sobre rasante y bajo rasante a la geometría de los volúmenes. 

7. Haremos un mapa temático de las alturas bajo rasante. 

 

8. Hacemos también un mapa temático de las alturas sobre rasante. 
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Cálculo de parcelas sobreedificadas y subedificadas  

 

1. Debemos fragmentar la geometría de ambas capas para obtener unas nuevas 
figuras que incorporarán las características (campos) de las entidades de las dos 
capas iniciales en las zonas donde haya superposición. 

                                      

2. Para ello ejecutamos la herramienta Analysis Tools → Overlay → Union con las 
capas "CONSTRU_AMBITO" y "Altura_Maxima" como Input Features y 
seleccionamos el apartado Join Atributes la opción NO_FID. Almacenamos el 
resultado en la capa "Union_Planeamiento_Volumetria". 

Con ello obtendremos los subpolígonos resultados de fraccionar las entidades de la 
capa planeamiento con las de la capa de volúmenes. Los subpolígonos resultantes 
contendrán la información el número de plantas edificadas de la capa de catastro y 
el número de plantas edificables de la capa planeamiento de las zonas donde se 
superponen. 

3. Creamos un nuevo campo en esta nueva capa (Union_Planeamiento_Volumetria) 
que llamaremos [DIREFENCIA]. Lo rellenamos con los valores de la diferencia entre 
la altura de planeamiento y la altura edificada. Si el valor es positivo existe un 
potencial de techo no edificado y si el valor es negativo la entidad está 
sobreedificada. 

Para poder obtener las parcelas sobreedificadas y subedificadas utilizaremos la 
volumetría que hemos obtenido de Catastro y la compararemos con la volumetría 
de planeamiento. 

Utilizaremos la capa "CONSTRU_AMBITO" que nos proporciona la posición y la 
geometría de los volúmenes construidos aunque como contrapartida, no nos 
permite trabajar con los usos, que están en la tabla "Construccion". 

No podemos utilizar la información de la tabla "Construccion" ni de la tabla 
"Unidad_Constructiva" puesto que no nos proporcionan información de la posición 
de los locales o de los edificios y no la podemos relacionar con la volumetría de 
planeamiento. 
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4. Para comprobar el resultado, realizamos un mapa temático con los fragmentos 
subedificados (verde), sobreedificados (naranja) y los que coinciden con el 
planeamiento (gris). 

 

12.3 Superficie sobreedificada y subedificada por parcela 

1. En primer lugar, crearemos dos campos en "Union_Planeamiento_Volumetria" para 
almacenar estos valores: 

 [SUP_SUB] 

 [SUP_SOBRE] 

2. Para calcular la superficie construida potencial de los fragmentos subedificados, 
seleccionamos los valores con la condición que [DIFERENCIA] < 0 y calculamos el 
valor para [SUP_SUB] con el valor absoluto del producto de [Shape_Area] y 
[DIFERENCIA] sólo para los registros seleccionados (superficie en planta multiplicada 
por el número de plantas subedificadas). 

3. Para calcular la superficie construida fuera de ordenación de los fragmentos 
sobreedificados, seleccionamos los valores con la condición que [DIFERENCIA] < 0 y 
calculamos el valor para [SUP_SOBRE] con el valor absoluto del producto de 
[Shape_Area] y [DIFERENCIA] sólo para los registros seleccionados (superficie en 
planta multiplicada por el número de plantas sobreedificadas). 

Queremos obtener, para cada parcela, las superficies construidas sobreedificadas y 
subedificadas, en metros cuadrados. Deberemos hacer los cálculos para cada 
fragmento y agrupar el resultado por parcela. 
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4. Para obtener los valores por parcela, agrupamos la suma de estos dos campos 
([SUP_SUB] y [SUP_SOBRE]) por [REFCAD] con la herramienta Analysis Tools → 
Statistics → Summary Statistics. 

5. Finalmente, vinculamos las tablas resultantes a la capa "PARCELAS_AMBITO" a 
través del campo [REFCAD], con lo que obtenemos las superficies construidas 
sobreedificadas y subedificadas en la capa gráfica de parcelas. 

6. Generamos los mapas temáticos de la superficie subedificada por parcela. 

 

7. Obtenemos también los mapas temáticos de la superficie sobreedificada por 
parcela. 
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12.4 Obtención de la volumetría en 3D 

1. Cargamos en ArcScene la capa "CONSTRU_AMBITO" y la tabla "Alturas.dbf".  

2. Vinculamos las dos tablas pulsando en "CONSTRU_AMBITO" con el botón derecho y 
seleccionando Joins and Relates → Join… para obtener las alturas en número de 
plantas de cada elemento. 

3. Pulsamos con el botón derecho del ratón en la capa "CONSTRU_AMBITO" y 
seleccionamos Properties. En la pestaña Extrusion seleccionamos Extrude features in 
layer y en Extrude value or expression elegimos el campo con la altura multiplicado 
por 3 (suponemos que la altura entre plantas es aproximadamente 3 metros). 

4. Cargamos la capa "Altura_Maxima". En la pestaña Extrusion seleccionamos Extrude 
features in layer y en Extrude value or expression elegimos el campo con la altura 
multiplicado por 3 (ocultamos la capa "CONSTRU_AMBITO" para poder visualizarla). 

5. Elegimos un color ladrillo para los volúmenes y un color rojo para las alturas de 
planeamiento. 

6. Para representar la volumetría encima del planeamiento, hacemos una vista 
seleccionando en Properties → Rendering Effects → Priority los siguientes valores: 

 Capa Volumetría: 1 

 Capa Planeamiento: 2 

En este caso la volumetría de planeamiento (rojo) que sobresale es la que no está 
materializada (imagen superior). 

7. Para representar el planeamiento encima de la volumetría, hacemos una vista 
seleccionando en Properties → Rendering Effects → Priority los siguientes valores: 

 Capa Volumetría: 2 

 Capa Planeamiento: 1 

En este caso los volúmenes que sobresalen están sobreedificados (imagen inferior). 

 

Visualizaremos las dos volumetrías (Catastro y Planeamiento) en 3D con el 
programa ArcScene, que forma parte del paquete ArcGIS. 

La visualización en un modelo 3D interactivo nos permitirá contrastar los 
resultados de manera más intuitiva. 
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13 Legislación y Normativa 

13.1 Internacional 

ISO 19113:2002 Geographic information - Quality principles 

ISO 19114:2003 Geographic information - Quality evaluation procedures 

ISO 19115:2003 Geographic information - Metadata 

13.2 Europea 

Directiva 2007/2/CE del Parlamento Europeo y del Consejo de la Unión Europea de 14 
de marzo de 2007 por la que se establece una infraestructura de información espacial 
en la Comunidad Europea (Inspire). 

13.3 Estatal 

Ley 7/1986 de 24 de enero de Ordenación de la Cartografía. 

Real Decreto 1545/2007, de 23 de noviembre, por el que se regula el Sistema 
Cartográfico Nacional. 

Real Decreto 585/1989 de 26 de mayo, por el que se desarrolla la Ley 7/1986 de 24 de 
enero, en materia de cartografía catastral. 

Orden FOM/956/2008, de 31 de marzo, por la que se aprueba la política de difusión 
pública de la información geográfica generada por la Dirección General del Instituto 
Geográfico Nacional. 

13.4 Catalana 

Llei 16/2005, de 27 de desembre, de la informació geogràfica i de l’Institut Cartogràfic 
de Catalunya. 

Decret 62/2010, de 18 de maig, pel qual s’aprova el Pla cartogràfic de Catalunya. 

Decret 398/2006, de 24 d’octubre, pel qual s’aprova el Reglament de 
desenvolupament de la Llei 16/2005, de 27 de desembre, de la informació geogràfica i 
de l’Institut Cartogràfic de Catalunya pel que fa a l’oficialitat i l’ús dels serveis 
cartogràfics i a les relacions interadministratives i la planificació. 

Llei 11/1994 d’11 de juliol, sobre els senyals geodèsics. 
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14 Enlaces web 

Comissió de Coordinació Cartogràfica de Catalunya 

http://www.cccartografica.cat/ 

 

Infraestructura de Dades Espacials de Catalunya 

http://www.geoportal-idec.cat/ 

 

Infraestructura de Datos Espaciales de España 

http://www.idee.es/ 





Formar a profesionales en el campo de los Sistemas de Información 
Geográfica es el principal objetivo del Máster SIG de la UPC, pionero en 
esta disciplina desde 1997, dónde se han formado activos profesionales 
de prestigio. Ha introducido y reforzado la capacidad y habilidad para 
aplicar los recursos que ofrecen los SIG para abordar cuestiones de 
planificación y gestión urbana en profesionales y técnicos habituados a 
trabajar con herramientas de diseño asistido por ordenador.

En los últimos años la implementación de las tecnologías de la 
información ha tenido un papel destacado en las administraciones 
locales. Los Sistemas de Información Geográfica  (SIG) se han hecho 
imprescindibles en muchos ámbitos en el tratamiento de información 
territorial y urbanística. 

Hoy resulta mucho más abordable por técnicos e instituciones la 
realización de mapas donde representar elementos y lugares 
singulares, donde referir información geoespacial de interés, pues se 
puede ejecutar con ordenadores estándar a precios accesibles para los 
profesionales, las administraciones y los ciudadanos. 

Esta publicación, aborda una experiencia de SIG de gestión de 
información urbanística en el ámbito local. Pretende explicar ese 
potencial analítico y de conocimiento, mediante un caso de estudio que 
muestra el proceso de elaboración y estructuración de información en 
SIG, con utilidad estratégica y práctica en las decisiones urbanas que 
atañen a la mejora y transformación de un centro urbano consolidado, la 
creación de vivienda, el fomento de ejes comerciales, entre otros.

Un documento que ha merecido la distinción de una ayuda para 
proyectos de mejora de la calidad docente de la formación permanente, 
2010-2011, de la Universidad Politécnica de Cataluña.


